Chapter 260

Two-Level Designs

Introduction

This program generates a $2^k$ factorial design for up to seven factors. It allows the design to be blocked and replicated. The design rows may be output in standard or random order. The output of this program will be to the current database with the data from the specified design. Hence, this particular program does not analyze data, it generates it.

When blocking is specified, the program checks to see if the design is listed on page 408 of Box and Hunter (1978). If it is one of the designs specified there, the indicated confounding pattern is used. If not, the blocks are confounded using the standard procedure in which highest-order interactions are confounded first, so long as they do not cause main effects to be confounded with blocks. The blocking pattern is reported by the analysis program, so it is not reported by this program.

Experimental Design

Experimental design is the planning of an efficient, reliable, and accurate technical study. The range of application of experimental design principles is as broad as science and industry. One person may be planning a long-term agricultural experiment, while another may have eight hours to rectify a production problem. How can we expect that the same methods are appropriate in all situations?

Of course, we cannot. Through the years, researchers and statisticians working together have outlined the basic steps necessary to conduct an effective investigation. These steps form an experimental strategy that seems to work well in many settings.

The experimental design modules lend you, the investigator, a hand with the planning and analysis of your investigation. Once you have determined the scope of your investigation, the design modules will provide a data collection plan that will minimize the amount of data collected and maximize the amount of conclusive information available. They will also provide a statistical analysis of your experimental results after the data have been collected.

The experimental design chapters will not attempt to teach you the principles of experimental design. There are many excellent books and pamphlets on this subject. The focus of the manual will be to remind you of the basic principles of experimental design and then explain where and how the program can help in your study. We suggest that you consult one or two of the following texts for detailed coverage of experimental design: Box, Hunter, and Hunter (1978), Davies (1956), Lawson (1987), or Montgomery (1984).
The Role of Statistics in Science

Statistics has been called the science of science. The scientific method consists of developing a theory or hypothesis, determining the consequences of this theory, and then comparing these consequences with facts (already available or determined from experimentation). When facts are found that contradict the theory, the theory must be modified, the consequences again determined, and all facts reconsidered.

The field of statistics is used in two phases of the scientific method. First, statistical design principles are used in the planning phase to determine an efficient and accurate method for collecting data (facts). Second, statistical analysis techniques are used to determine if the data are compatible with the proposed theory. Tools are provided for both of these phases in our statistical package.

Experimental Design Definitions

Alias
Two terms are aliased if their levels are identical throughout the design (except possibly for a difference in sign). Aliasing occurs in designs that are less than one full replication. The two terms are completely confounded with one another. It is impossible to determine from the data if an effect is due to the first, second, or both terms.

Blocking
A block refers to a batch of runs conducted together. For example, a block may be the experiments run on a particular day, or the experiments conducted on a particular batch of material.

Confounding
Two terms are confounded when their influences on the response variable cannot be separated. Confounding usually occurs when blocks are equated to high-order interactions.

Experiment (Run)
An action to at least one of the items being studied which has an observable outcome. Each run produces one observation (value) of the response variable.

Experimental Design
The collection of experiments to be completed during an investigation or study.

Experimental Error
The influence on the response of all independent variables not included in the study. This error is a fact of life, since it is usually impossible to control every independent variable that might influence the response.

Factorial Designs
A factorial design consists of all combinations of factor levels of two or more factors. The designs we generate all have factors with two, three, or five levels. Most of the designs are two-level designs. Since the total number of factor-level combinations is the product of the number of levels of each factor, these two-level designs are known as $2^k$ factorial designs (where $k$ is the number of factors).

The two levels of each factor are often referred to as the high and the low levels. For example, if one of the factors were agitation at 100 rpm and 200 rpm, then 100 would be the low level and 200 would be the high level.
Two-Level Designs

The designs produced by this program are orthogonal. This means that an equal amount of information is provided about the influence of each factor. It also means that there is no overlapping of information. The study clearly shows the unique influence of each factor.

One of the greatest strengths of the factorial experiment is that it allows the study of several factors at once, rather than only one factor at a time. Since each factor is paired with all possible combinations of the other factors, the researcher is confident that the measured effect of the factor is valid under a broad range of conditions.

**Independent Variable (Factor)**
A variable whose influence on the response variable is being studied by deliberately varying it from run to run.

**Interaction**
The interaction among factors refers to that part of the change in the response from run to run that may be accounted for by a specific combination of two or more factors. Another way of explaining interaction is that the average effect of one factor depends on the level of another factor.

The order of an interaction is the number of factors in the interaction. Hence AB is a second-order interaction and ABCD is a fourth-order interaction.

The Taylor’s series expansion of a function is often used to justify the assumption that higher-order interactions are less significant (smaller influence on the response) than are main effects and low-order interactions.

**Levels**
A factor (independent variable) is set at different values or levels during an experiment.

**Main Effect**
The change in the average response as a factor is varied is called the main effect of that factor. In a factor with two levels, the main effect is the average of all runs at the high level of the factor minus the average of all runs at the low level of the factor.

**Response or Dependent Variable**
The variable whose value is observed at the completion of each run.

**Replication**
This is the number of times an experiment is repeated at identical factor levels. You must have some replication to determine the underlying (error) variability that occurs in the experiment. One rep refers to the running of every possible factor combination. Designs may be partially replicated (a few treatment settings are repeated), fractionally replicated (less than one complete replication), or completely replicated. It should be obvious that each time a run is repeated, the precision of the experimental results is increased.

**Two-Level Factorial Designs**
All of the designs provided are factorial designs. Two-level designs are those in which all factors have only two values. This may seem like a severe restriction, but in many studies, this is all that is needed.

Factorial designs allow you to fit linear (as opposed to quadratic) models with all possible interactions. The number of runs is often quite large, so the runs are often grouped together in blocks.
Fractional Factorial Designs
Fractional factorial designs are constructed by taking well-chosen subsets of a complete factorial design. Fractional factorials are useful because they require much fewer runs, although they do not allow the separation of main effects from high-order interactions.

This program gives two-level fractional factorial designs. These are usually defined as one-half rep, one-quarter rep, etc. They may be run all at once or in blocks.

Screening Designs
Screening designs are used in the initial phases of a study when you wish to investigate the main effects of several factors (up to 31) simultaneously. These designs allow you to determine which factors warrant closer investigation and which may be ignored.

Screening designs allow the investigation of main effects only. They use a small fraction of the total runs that would be needed for a complete factorial design.

Many of the Taguchi designs are really screening designs.

Response Surface Designs
The program provides Central Composite and Box-Behnken response surface designs. These designs provide for factors with more than two levels.

Procedure Options
This section describes the options available in this procedure.

Design Tab
This panel specifies the parameters that will be used to create the design values.

Experimental Setup

Replications
The number of replications (repeats) of the entire experiment.

Block Size
The number of experiments (runs) per block. This determines the number of blocks. This number must be a power of 2 (2, 4, 8, 16, etc.)

Sort Order
The order of the generated rows. The rows may be in random or standard order.

- Random
  The rows are randomly ordered (random blocks and random rows within blocks). Use this option when the order of application to experimental units is governed by the row number.

- Standard
  The rows are not randomly ordered. Instead, they are placed in standard order. Use this option when you want to quickly see the structure of the design.
Experimental Setup – Factor Values

Factor Values
Each factor has two possible values (levels) which are specified here. These are the values that will be written to the database. The first value is used to represent the low value. The second value represents the high value. You may use both text and numeric values.

The number of variables created depends on how many of these boxes have values in them.

Data Storage

Store Data with the Dataset
Check this box to generate the design data on the dataset. The data will be identical to the design data generated on the output window.

Block Column
The column to contain the block identification numbers. The blocks are numbered from one to B, where B is the number of blocks.

First Factor Column
This is where the group of columns that is to contain your design begins. The K-1 columns after this column are also filled with data. The number of columns used is determined by the number of Factor Values boxes that contain data.

Warning: The program fills these columns with data, so any previous data will be lost.

Example 1 – Two-Level Design

This section presents an example of how to generate an experimental design using this program. CAUTION: since the purpose of this routine is to generate (not analyze) data, you should always begin with an empty dataset.

In this example, we will show you how to generate a five-factor design in blocks of eight runs each. You may follow along here by making the appropriate entries or load the completed template Example 1 by clicking on Open Example Template from the File menu of the Two-Level Designs window.

1 Open a new (empty) dataset.
   • From the File menu of the NCSS Data window, select New.
   • Click the Ok button.

2 Open the Two-Level Designs window.
   • Using the Analysis menu or the Procedure Navigator, find and select the Two-Level Designs procedure.
   • On the menus, select File, then New Template. This will fill the procedure with the default template.

3 Specify the design parameters.
   • On the Two-Level Designs window, select the Design tab.
   • Select 1 in the Replications box.
   • Select 8 in the Block Size box.
   • Select Standard in the Sort Order box.
   • Set the first Factor Value box to 1 2.
   • Set the second Factor Value box to 10 20.
   • Set the third Factor Value box to Low High.
   • Set the fourth Factor Value box to -1 1.
Two-Level Designs

- Set the **fifth Factor Value** box to 0 1.
- Check the box Store Data with the Dataset.
- Enter 1 in the **Block Column** box.
- Enter 2 in the **First Factor Column** box.

4 Run the procedure.
- From the Run menu, select **Run Procedure**. Alternatively, just click the green Run button.

---

Sample Design Data

<table>
<thead>
<tr>
<th>C1</th>
<th>C2</th>
<th>C3</th>
<th>C4</th>
<th>C5</th>
<th>C6</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>10</td>
<td>Low</td>
<td>-1</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>20</td>
<td>Low</td>
<td>-1</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>10</td>
<td>High</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>20</td>
<td>High</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>10</td>
<td>High</td>
<td>-1</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>20</td>
<td>High</td>
<td>-1</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>10</td>
<td>Low</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>20</td>
<td>Low</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>10</td>
<td>Low</td>
<td>-1</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>20</td>
<td>Low</td>
<td>-1</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>10</td>
<td>High</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>20</td>
<td>High</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>10</td>
<td>High</td>
<td>-1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>20</td>
<td>High</td>
<td>-1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>10</td>
<td>Low</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>20</td>
<td>Low</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>10</td>
<td>High</td>
<td>-1</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>20</td>
<td>High</td>
<td>-1</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>10</td>
<td>Low</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>20</td>
<td>Low</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>10</td>
<td>Low</td>
<td>-1</td>
<td>1</td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>20</td>
<td>Low</td>
<td>-1</td>
<td>1</td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>10</td>
<td>High</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>20</td>
<td>High</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td>10</td>
<td>High</td>
<td>-1</td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>2</td>
<td>20</td>
<td>High</td>
<td>-1</td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>2</td>
<td>10</td>
<td>Low</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td>20</td>
<td>Low</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>2</td>
<td>10</td>
<td>Low</td>
<td>-1</td>
<td>1</td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td>20</td>
<td>Low</td>
<td>-1</td>
<td>1</td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td>10</td>
<td>High</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>4</td>
<td>2</td>
<td>20</td>
<td>High</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

Notice C1 contains the four block indices, and variables C2 through C6 contain the generated design values.

You would now proceed with your experiment, obtain the real response values, and analyze the data using one of the analysis of variance routines or the Analysis of Two-Level Designs procedure.